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EXECUTIVE SUMMARY 

Kellogg’s buckwheat (Eriogonum kelloggii) is a perennial plant that is designated as endangered 

under the California Endangered Species Act. Kellogg’s buckwheat is endemic to serpentine 

habitat of lower montane forest in the northern Coast Range in Mendocino County, California. 

The species is found on dry ridges in rocky barren openings associated with serpentine habitat 

between 1,900 and 4,100 ft (580 and 1,250 m) in elevation. Kellogg’s buckwheat is almost 

entirely restricted to private and Bureau of Land Management (BLM) land at Red Mountain; 

however, one small population of Kellogg’s buckwheat occurs at the California Department of 

Fish and Wildlife (CDFW) Little Red Mountain Ecological Reserve (Reserve).  

CDFW staff visited the Reserve in 2003, and again in 2015 and 2017 to document the condition 

of the Kellogg’s buckwheat population, search for additional populations Kellogg’s buckwheat 

and make other observations. Considering field notes from 2003 and information generated 

from monitoring visits in 2015 and 2017, it is clear that the population of Kellogg’s buckwheat 

suffered a significant decline between 2003 and 2017. The Kellogg’s buckwheat population 

occurred on both sides of a fire road in 2003, but now only occurs on the west side of the fire 

road. Monitoring visits in 2015 and 2017 also show a significant decline in the population, 

primarily due to the deaths of several plants in an approximately two by three meter area of the 

population. There is no obvious reason for the deaths of these Kellogg’s buckwheat plants 

between 2015 and 2017. Losses could have occurred due to a small land slide localized in this 

area or as a result of some other factor such as canopy shading or excessive rainfall in the 

winter and spring of 2017.   

The monitoring plan presented in this document should be implemented by CDFW staff to 

facilitate the adaptive management of Kellogg’s buckwheat at the Reserve. Due to the 

remoteness of the Reserve and lack of ongoing funding to conduct monitoring, it is 

recommended that another CDFW visit to the Reserve be scheduled in 2022. If a population of 

at least ten Kellogg’s buckwheat plants with a diameter of 10 centimeters or greater is not 

present at Little Red Mountain Ecological Reserve at the time of the next monitoring visit, 

CDFW should implement a management response in 2023. Recommended management 

responses include collecting seeds from remaining plants in 2023, preserving seeds in long-

term conservation storage, and initiating a seed germination study. Additional management 

responses could also be considered in 2023, if necessary.  

Several other rare plants are known to occur on the Reserve and should continue to be 

documented during monitoring visits in the future.  
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1. INTRODUCTION  
Kellogg’s buckwheat (Eriogonum kelloggii) is a perennial plant designated as endangered under 
the California Endangered Species Act. The species was a candidate for listing under the 
federal Endangered Species Act, but on September 18, 2014, the U.S. Fish and Wildlife Service 
found that listing Kellogg’s buckwheat was not warranted. Kellogg’s buckwheat is endemic to 
serpentine habitat of lower montane forest in the northern Coast Range in Mendocino County, 
California. The species is found on dry ridges in rocky barren openings associated with 
serpentine habitat between 1,900 and 4,100 ft (580 and 1,250 m) in elevation.  

Kellogg’s buckwheat is almost entirely restricted to private and Bureau of Land Management 
(BLM) land at Red Mountain; however, one small population occurs at the California 
Department of Fish and Wildlife (CDFW) Little Red Mountain Ecological Reserve (Reserve) 
(Figures 1 and 2). CDFW purchased the approximately 2,400-acre Reserve from the Coastal 
Mining Company in 1988. This Monitoring Plan focuses on the approximately 850-acre western 
area of the Reserve that is associated with serpentine habitat (Study Area). The Study Area 
also supports populations of the state endangered Red Mountain catchfly (Silene campanulata 
subsp. campanulata), white-flowered rein-orchid (Piperia candida, California Rare Plant Rank 
1B.2), Sonoma canescent manzanita (Arctostaphylos canescens ssp. sonomensis, California 
Rare Plant Rank 1B.2), and redwood lily (Lilium rubescens, California Rare Plant Rank 4.2). An 
individual Raiche's manzanita plant (Arctostaphylos stanfordiana subsp. raichei, California Rare 
Plant Rank 1B.1) was also observed in the Study Area on June 13, 2003. 

The Study Area is surrounded by BLM land and private property and is very difficult to access. 
The Study Area is not open to the public and appears to be visited very infrequently. Ecological 
reserve signs have been posted in the Study Area, but the Reserve is otherwise unmanaged.  

This Little Red Mountain Ecological Reserve Kellogg’s Buckwheat Monitoring Plan (Monitoring 
Plan) should be implemented by CDFW staff in the Study Area. The purpose of the Monitoring 
Plan is to monitor the status of the Kellogg’s buckwheat population and other rare plants in the 
Study Area, expand CDFW’s knowledge of the Study Area, and identify and alleviate threats to 
the Study Area before they become prohibitively expensive to address. Due to the remoteness 
and relatively low threats to the Study Area, this Monitoring Plan only involves visiting the Study 
Area every five years. CDFW staff should visit the Study Area again in June of 2022 to 
document the status of Kellogg’s buckwheat.  

This Monitoring Plan provides background information on the monitoring approach used, 
detailed instructions on how to collect both qualitative and quantitative data on the population of 
Kellogg’s buckwheat in the Study Area, and suggested management responses. This 
Monitoring Plan is intended to provide a powerful foundation for adaptive management of 
Kellogg’s buckwheat in the Study Area, but it is not intended to be so rigid as to preclude 
adaptation and flexibility in the future. The monitoring consists of three parts: 

1. A census documenting the size and location of all Kellogg’s buckwheat plants in the 
Study Area relative to a baseline,  

2. Photomonitoring of the Kellogg’s buckwheat population, and 
3. Opportunistic surveys of the Study Area for Kellogg’s buckwheat and other plants. 

1.1. SITE DESCRIPTION 

The Study Area consists of a mosaic of mixed coniferous forest/Jeffrey pine woodland/chaparral 
vegetation types on serpentine substrates. The most common shrub species in the vicinity of  
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the Kellogg’s buckwheat population is Sonoma canescent manzanita. The highest point in the 
Study Area is the forested peak of Little Red Mountain on the west side of the Study Area. The 
east half of the Study Area is generally lower in elevation than the west half of the Study Area.  

There is evidence of past mining activity in the form of roads and exploratory soil excavations 
throughout the Study Area. Vegetation and roads on the Reserve were also cleared in the Study 
Area in 2008 for firefighting purposes. The Kellogg’s buckwheat population may have been 
impacted by the fire control efforts, but no survey of the area was completed. Regardless, in an 
attempt to restore the impacts of the fire suppression activities, CDFW staff worked extensively 
with California Department of Forestry and Fire Protection (CalFire) to redistribute earth material 
back over the disturbed areas that had been created for safety zones during the 2008 fires. 

2. ECOLOGICAL MODEL 
An ecological model for Kellogg’s buckwheat is not provided because so little is known about 
the life history of the species.  

2.1. LIFE HISTORY OF KELLOGG’S BUCKWHEAT 

Little is known about the life history of Kellogg’s buckwheat. Known information about the 
species is presented in the U.S. Fish and Wildlife Service Species Report for the Two Red 
Mountain Plants: Red Mountain Buckwheat (Eriogonum kelloggii) and Red Mountain Stonecrop 
(Sedum eastwoodiae), dated September 2014.  

Kellogg’s buckwheat is a perennial herb that blooms between May and August. The exact 
lifespan of Kellogg’s buckwheat is not known. Eriogonum species occupying restricted habitats 
similar to those occupied by Kellogg’s buckwheat, and which are adapted to similar 
environmental and ecological conditions (e.g., xeric conditions, limited resources, tolerance of 
unique soils) have long lifespans and tend to grow slowly and favor individual persistence 
(Anderson 2006). Based on the persistence of Kellogg’s buckwheat populations that have been 
monitored on Red Mountain, the lifespan of Kellogg’s buckwheat is also expected to be long.  

Annual monitoring of 13 permanent plots at three study sites on Red Mountain by Baad (2002) 
between 1987 and 1998, and again in 2002 showed considerable annual variation in plant 
density and reproductive success, but no discernible long-term trends at two of the three study 
sites. One study site exhibited a decline in plant density by 65 percent over the past 11 years, 
and a second area exhibited a pronounced reduction in reproductive success since 1998. The 
latter study area is located adjacent to and within a stand of knobcone pine (Pinus attenuata) 
that burned approximately 45 years ago. The decline in reproductive success may be a result of 
progressive growth of trees and shrubs leading to canopy closure as part of the recovery from 
fire (Baad 2002).  

3. MANAGEMENT OBJECTIVES 
The initial management objective is: 

• Maintain a population of at least ten Kellogg’s buckwheat (Eriogonum kelloggii) plants 
with a diameter of ten centimeters or greater at Little Red Mountain Ecological Reserve 
at the time of the next monitoring visit, expected to be in 2022. (This is a target/threshold 
type of management objective.)  
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4. MONITORING DESIGN 

4.1. CENSUS OF POPULATION 

As part of the Monitoring Plan, all Kellogg’s buckwheat plants in the known population in the 
Study Area should be mapped relative to the monitoring baseline, measured, and the 
phenological condition should be recorded. The 15 meter-long monitoring baseline was 
established near the population to facilitate monitoring.  

This protocol is designed to be completed by two to three monitors over two or three field days 
every five years. At least one of the monitors should be an experienced botanist. The monitoring 
should be conducted when Kellogg’s buckwheat is most likely to be in bloom, likely in June. 
Because Kellogg’s buckwheat is a perennial plant, monitoring could likely be conducted at any 
time of year that the site is accessible.  

 BEFORE GOING INTO THE FIELD 

Print out all of the necessary data sheets, this monitoring plan, and trip reports from previous 
monitoring years. Necessary data sheets include:  

• Combined Vegetation Rapid Asessment and Releve Field Form with Instructions; 

• Photomonitoring Log: Little Red Mountain Ecological Reserve Plot 1; 

• Graph paper to record sizes and locations of Kellogg’s buckwheat relative to the 
baseline; 

• California Native Species Field Survey Form; 

• Qualitative Monitoring Datasheet. 

Reserve a date to conduct the monitoring, recruit field helpers and contact the Reserve 
manager about your plans (Scott Koller in 2018). Secure a high clearance 4-wheel drive vehicle 
to access the Reserve because the access roads are very rugged. Contact the adjacent 
landowner (contact information on file) to inquire about the condition of the access road, and to 
provide information on your plans.  

All monitors should familiarize themselves with the species being monitored, the Reserve, this 
Monitoring Plan and the data that has been previously collected. Request field assistance from 
Northern Region staff.  

The Study Area is very remote, so it is important to bring everything that will be needed for the 
duration of the trip. Gather the equipment and materials listed below: 

• Ten essentials for camping (with some examples);  
o navigation (maps, compass, PGS receiver),  
o sun protection (hat, sunscreen),  
o insulation (warm clothes and sleeping bag), 
o illumination (flashlights), 
o first-aid supplies, 
o fire supplies (lighter, matches), 
o repair kits and tools (knife), 
o food, 
o water (there is no water available in the Study Area), 
o shelter (tent), 
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• Monitoring Plan, datasheets, previous site visit summaries, plant list and other 
references;  

• Clipboards, pencils; 

• Combination to access gates;  

• Tow chain; 

• Chainsaw, tree saw, loppers; 

• (2+) 100-meter tapes; 

• (2+) 50-meter tapes; 

• Screwdrivers or other tools for pinning meter tapes to the ground; 

• (many) Pin Flags; 

• Permanent marker;  

• (3+) Hand tally counters; 

• Replacement field markers (aluminum conduit and/or rebar with caps and lengths of 
pvc); 

• PVC cutter; 

• Tape measure; 

• Small sledgehammer; 

• GPS for relocating field markers and documenting plant locations; 

• Tripod, camera, charged batteries and memory card; 

• Compass; 

• Zip-lock bags and/or plant press; 

• Metal detector for relocating missing field monument locations. 

 IN THE FIELD 

From Highway 101, exit 609 and go to the north side of Highway 101. Proceed through the first 
gate to the Reserve using the appropriate combination. Access to the Reserve requires crossing 
through private property. Make efforts to contact the landowner prior to visiting the site, and 
inquire about road conditions. The landowner has volunteered to check and clear the road of 
obstructions prior to previous site visits. The road to the Reserve was very rutted and worn in 
2017, and passage required a high clearance vehicle. A second locked gate is also on the 
route. Use the appropriate combination to open it. The access route from Highway 101 is 
available online (at https://binged.it/2sYmy7o) and in Figure 3. There is a third gate near the 
Reserve boundary. The driving route to the west side of the Study Area requires driving over 4-5 
foot tall regenerating shrubs and may involve clearing downed trees and woody debris. There is 
a place to park and camp at 39.874344°, -123.667687°. The Kellogg’s buckwheat population 
and monitoring baseline is accessible on foot by turning left at the road junction (39.874455°, -
123.668826°).  

The two monuments that mark the ends of the monitoring baseline were hammered into the 
west side of the road, 15 meters apart. The monuments consist of rebar hammered into the 
ground, with a PVC pipe around it, with a red plastic cap, all surrounded by square aluminum 
conduit, with an aluminum marker tab (Figure 4). The monuments were named CDFW Plot 1 
South (39.870438°, -123.669810°) and CDFW Plot 1 North (39.870573°, -123.669812°). A third 
monument named “Plot 1 photo point” is on the east side of the road (39.870511°, -
123.669765°).  

The monitoring baseline was deliberately placed alongside all Kellogg’s buckwheat plants found 
on the Reserve in 2015. Surveys in 2017 did not lead to the discovery of any additional 
Kellogg’s buckwheat outside of the areas alongside the monitoring baseline.  

https://binged.it/2sYmy7o


Figure 3 
Access Route to Little Red Mountain Ecological Reserve Study Area 
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Figure 4 
Photos of Eriogonum kelloggii (top) and Plot 1 North Monument (bottom) 
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If any of the monuments are missing, they should be replaced before monitoring begins. If a 
monument cannot be relocated, monitors should use meter tapes, the remaining rebar 
monuments and compass bearings to place new rebar monuments in the appropriate positions, 
and continue the monitoring. Monitors should also add additional back-up monuments if 
necessary. Any missing and replacement monuments should be documented in the field notes 
for the day.  

Collect Data 

Flag all Kellogg’s buckwheat plants with pink pin flags, being extremely careful not to disurb any 
soil in the steep, and easily erodible areas above the road cut (see Figure 4). Some very small 
Kellogg’s buckwheat plants may be in the road, so be careful not to step on them when you first 
arrive at the population. Next, lay a meter tape between the two monuments (from south to 
north), and use a tape measure and compass bearing to measure the location of each plant, or 
clump of plants relative to the baseline. Record the point where each plant is closest to the 
baseline. If separate plants are less than 10 cm apart from each other, they are counted as one 
“clump”. In addition, record the widest part of each clump, and the phenological condition of 
each plant or clump (flowering, fruiting, or not). Finally, photograph each clump in a way so that 
you can reference each photo to the monitoring data collected for that clump. Writing the plant 
number on a pin flag next to the plant is a good way to do this.   

A third monument, named “Plot 1 photo point” was placed on the east side of road, due east of 
the 7.5 meter mark on the baseline (half-way between the plot monuments that are on the west 
side of the road). Take the seven monitoring photographs that are described in the 
photomonitoring datasheet.  

Complete a qualitative monitoring datasheet. 

 BACK IN THE OFFICE 

• Scan, save and re-name all field data sheets. The current project folder is: 
U:\Groups\HCPB\Shared Folders\NPP\Section 6\2014\Priority Plant Surveys\Project 
Files\Little Red Mountain. This project folder is likely to change in the future.  

• Compare the results with previous years results and make graphs of the data. Talk to 
the Reserve manager about adaptive management of the site. This is the most 
important part of adaptive management! 

• Download and rename field photos (Section 4.2) and compare them with monitoring 
photos from previous years.  

4.2. PHOTOMONITORING FOR ADAPTIVE MANAGEMENT 

Photomonitoring should be conducted at the same time that the population census data is 
collected for the Study Area.  

 BEFORE GOING INTO THE FIELD 

The monitor conducting the photomonitoring should be trained and familiar with the proper use 
of a field compass and the type of digital camera and tripod that will be used. The following 
equipment is required: 

• Clipboard with photomonitoring log sheet; 

• Pen or pencil; 
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• Digital camera with fully-charged batteries and available memory: a compact digital SLR 
camera with a standard 18-55mm zoom lens is preferred for ease of photo comparison;  

• Tripod; 

• Compass set to the correct declination for the site (14 degrees east). 

To duplicate approximately the same field of view from year to year, the camera should be set 
to a focal length that is equivalent to a focal length of approximately 27mm on a “full frame” 
camera such as a 35mm film camera or a Nikon “FX” camera and lens. Monitoring photographs 
for the initial 2015 photomonitoring were taken using a Nikon “DX” camera and lens, set to a 
focal length of 18mm, which is equivalent to 27mm on a “full frame” camera and lens. Before 
visiting the site, check the specifications for digital cameras that may be used for the monitoring 
to see if photographs can be taken with the correct field of view. If the camera equipment to be 
used cannot duplicate this field of view, the closest field of view possible should be used.  

 IN THE FIELD 

All monitoring photographs are taken from a monument, or a certain distance from a monument. 
Refer to the photomonitoring datasheet for the locations of monuments, and the order that 
monitoring photos should be taken. Once at the location of the monitoring photograph, do the 
following: 

• Set up the tripod and camera so that the center of the camera lens is 5 feet (152cm) 
above the ground (the maximum height for many tripods), and directly above the 
appropriate location on the ground.  

• Populate Each Page of the Photomonitoring Log with the date, photographer name, 
focal length, camera, lens and camera settings, and any other relevant information.  

• Take a “Slate” Photo of the first page of the Photomonitoring Log sheet itself before 
taking all of the monitoring photos on that page.  

• Take monitoring photos in the order that they are listed on the photomonitoring 
datasheet. Follow these rules: 

o Use the field compass to ensure that all photos are taken in the direction 
indicated in the Photomonitoring Log. 

o Make sure that the camera’s zoom lens is set to the correct focal length (e.g. 18 
mm on a Nikon d3100/d3300). 

o Set up the camera so that the horizon is 1/4 of the way down from the top of the 
frame. Many cameras have a focus point at this location within the viewfinder.  

o Make sure the horizon in the viewfinder is as horizontal as possible.  
o Make sure that the camera focuses properly before taking the picture, and use 

the preview function of the camera to make sure that the photo has been taken 
correctly. 

    

    

    

    

Center the horizon in the camera viewfinder at the area indicated with the red arrow 
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 BACK IN THE OFFICE 

Save all monitoring photos in the in a folder on the shared drive that corresponds with the year 
of the field visit, for example: “U:\Groups\HCPB\Shared Folders\NPP\Section 6\2014\Priority 
Plant Surveys\Project Files\Little Red Mountain\2017 Monitoring Visit”  

Carefully change the names of the photo files using the following convention: Plot [plot number] 
Photo [uppercase photo letter] [four digit year][two digit month][two digit day of the month]. For 
example if a Photo A is taken at Plot 1 on June 9, 2015 the file should be named “Plot 1 Photo A 
20150609”. 

All properly named monitoring photos should be saved in the following folder on the shared 
drive: U:\Groups\HCPB\Shared Folders\NPP\Section 6\2014\Priority Plant Surveys\Project 
Files\Little Red Mountain\All Monitoring photos. The location of this folder may change in the 
future. 

With the monitoring photos saved, use the Windows Photo Viewer or similar program and the 
left and right arrow keys on the keyboard to compare monitoring photos with those taken during 
previous site visits. If the monitoring photos are misaligned, it may be difficult to interpret the 
differences between monitoring photos. It is possible to align the monitoring photos more 
precisely by carefully manipulating them using Photoshop or other photo editing software. This 
is helpful for showing precisely how specific areas of the ground have changed over the years. 
Guidelines for aligning monitoring photos using Photoshop CS6 is provided as an appendix to 
this Monitoring Plan.  

4.3. OPPORTUNISTIC SURVEYS OF THE STUDY AREA 

The Study Area is seldom visited. CDFW staff should attempt to survey areas that have not 
been visited and make additional observations during the course of site visits. CDFW staff 
should search for additional populations of Kellogg’s buckwheat, Red Mountain catchfly, 
Sonoma canescent manzanita, redwood lily, Raiche's manzanita, and other rare plants that may 
be present. Scientific collections of plant specimens should be made, and the plant list for the 
Study Area should be updated.  

5. RESPONSIBLE PARTIES 
CDFW staff in the Native Plant Program or Northern Region (Region 1) should implement this 
Monitoring Plan and report results and recommended actions to the Reserve manager after 
each site visit. The Reserve manager should make decisions on how to adaptively manage the 
Reserve. 

6. FUNDING 
CDFW staff in the Native Plant Program used grant funding from the U.S. Fish and Wildlife 
Service Cooperative Endangered Species Conservation Fund (F15AP00059) and other funding 
sources including funds from the Rare and Endangered Species Preservation Fund to prepare 
this Monitoring Plan and collect monitoring data in 2015 and 2017. Continuation of this 
Monitoring Plan after 2021 is likely dependent on the ability of staff in the Native Plant Program 
to use staff time funded by the Rare and Endangered Species Preservation Fund, general fund, 
and other programs to do so. Field helpers can often be borrowed from other CDFW programs if 
the appropriate program managers approve the work as cross training for their staff. 
Implementation of this Monitoring Plan could also be implemented by staff in CDFW’s Northern 
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Region or by CDFW volunteers. It is estimated that implementation of this Monitoring Plan will 
require the following: 

In-office preparations: 16 hours by one environmental scientist or senior environmental scientist 
(specialist) = 16 hours 

Field visits to collect data: 28 hours by one environmental scientist or senior environmental 
scientist (specialist) and one other field helper = 56 hours 

In-office data analysis, typing of field notes and reporting: 24 hours by one environmental 
scientist or senior environmental scientist (specialist) = 24 hours 

TOTAL STAFF TIME NEEDED: Approximately 96 hours of staff time every five years, or 
approximately 19 hours per year 

Preparation of periodic summary reports and presentation of results will likely require additional 
time. A summary report for 2015-2017 has been prepared, and is included as part two of this 
report.  

7. MANAGEMENT IMPLICATIONS OF POTENTIAL 

RESULTS 
Management Implication 1: If a population of at least ten Kellogg’s buckwheat (Eriogonum 
kelloggii) plants with a diameter of 10 centimeters or greater is not present at Little Red 
Mountain Ecological Reserve at the time of the next monitoring visit, expected to be in 2022, 
CDFW shall organize and initiate an effort to collect seeds from remaining plants in 2023, and 
preserve them in long-term conservation storage.  

Management Implication 2: If a population of at least ten Kellogg’s buckwheat (Eriogonum 
kelloggii) plants with a diameter of 10 centimeters or greater is not present at Little Red 
Mountain Ecological Reserve at the time of the next monitoring visit, expected to be in 2022, 
CDFW shall organize and initiate a seed germination study, and attempt to grow Kellogg’s 
buckwheat plants in a controlled environment, in an effort to obtain information that could lead to 
reintroduction of Kellogg’s buckwheat to Little Red Mountain Ecological Reserve, if necessary.  
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9. DATA SHEET EXAMPLES 
The following pages are examples of field data sheets that may be used or modified for 
monitoring. 



Little Red Mountain Ecological Reserve Eriogonum kelloggii monitoring datasheet                      Date: 
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Photomonitoring Log: Little Red Mountain Ecological Reserve Plot 1 

Shoot all with a focal length equivalent to 27mm on a full frame camera (e.g. 18mm on a Nikon dx lens). 

All photos should be shot from 5 feet above the ground, with the subject framed as described below.   

Date of observation:    Camera and Lens:   

Observer(s): __________________________ Focal Length:______ Camera Setting: ____________ 

 

Photo 
point 

From Toward Description/Notes Photo file name in 
camera 

A Photo Monument South Plot 
Monument 

Monument centered in bottom 1/3 of 
view 

 

B Photo Monument 7.5 meters 
(halfway 
between 
monuments)  

7.5 meter mark centered in bottom ¼ 
of frame 

 

C Photo Monument North Plot 
Monument 

Monument centered in bottom 1/3 of 
view 

 

D North Plot 
Monument 

South Plot 
Monument 

Monument centered in top 1/3 of 
view 

 

E South Plot 
Monument 
(camera moved 
150 cm east of 
monument to 
avoid manzanita) 

North Plot 
Monument 

Monument centered in top 1/3 of 
view 

 

F Approximately 3 
meters south of 
Photo Monument 

7.5 meters 
(halfway 
between 
monuments) 

7.5 meter mark centered in bottom ¼ 
of frame 

 

G Approximately 3 
meters north of 
Photo Monument 

7.5 meters 
(halfway 
between 
monuments) 

7.5 meter mark centered in bottom ¼ 
of frame 

 

           

North Plot Monument South Plot Monument 

Photo Monument 
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For Office Use: Final database #: 
Final  vegetation type: 

Alliance______________________________________________ 

Association 

I. LOCATIONAL/ENVIRONMENTAL DESCRIPTION circle:    Relevé   or   RA 

Database #: Date: Name of recorder: 

    Other surveyors: □ 

 UID: Location Name: □ 
 

GPS name: __________                                                     For Relevé only:   Bearing°, left axis at ID point_____ of  Long  /  Short  side □ 
 

UTME ___ ___ ___ ___ ___ ___  UTMN ___ ___ ___ ___ ___ ___ ___      Zone: 11    NAD83   GPS error: ft./ m./ PDOP _____  

Decimal degrees:     LAT  ___ ___ . ___ ___ ___ ___ ___ ___        LONG  ___ ___ ___ . ___ ___ ___ ___ ___ ___   

 

GPS within stand?    Yes  /  No   If No, cite from GPS to stand:     distance (m) _____      bearing ° _____     inclination ° _____  

       and record:  Base point ID ____________________      Projected UTMs:  UTME ___ ___ ___ ___ ___ ___   UTMN ___ ___ ___ ___ ___ ___ ___ 

□ 

□ 

Camera Name:         Cardinal photos at ID point: □ 
Other photos: 
 

Stand Size (acres):   <1,   1-5,   >5     |   Plot Area (m2):  100 /  ______   |  Plot Dimensions ____ x____ m      |      RA Radius____ m 
 
Exposure, Actual º: ______  NE    NW    SE    SW    Flat   Variable  |  Steepness, Actual º: ______    0º     1-5º      > 5-25º     > 25 

□ 

□ 

Topography:    Macro:     top     upper     mid     lower     bottom    |     Micro:     convex     flat     concave     undulating  

Geology code: _____________  Soil Texture code: ______________     |     Upland  or  Wetland/Riparian (circle one) 
 

% Surface cover:                                   (Incl. outcrops)    (>60cm diam)       (25-60cm)        (7.5-25cm)     (2mm-7.5cm)   (Incl sand, mud) 

H20:          BA Stems:          Litter:           Bedrock:          Boulder:          Stone:          Cobble:          Gravel:          Fines:          =100%               

□ 

□ 

 

□ 

% Current year bioturbation ______    Past bioturbation present?    Yes  /   No     |     % Hoof punch ______   

Fire evidence:   Yes  /  No (circle one) If yes, describe in Site history section, including date of fire, if known.  

□

□ 
 

Site history, stand age, comments: □ 
 

 

 

 

 

 

 

 

 

Disturbance code / Intensity (L,M,H): _____/____  _____/____  _____/____  _____/____  _____/____ “Other” _______________ / ____    
 

□ 

II. HABITAT DESCRIPTION 
 

 

Tree DBH : T1 (<1” dbh),  T2 (1-6” dbh),  T3 (6-11” dbh),  T4 (11-24” dbh),  T5 (>24” dbh), T6 multi-layered  (T3 or T4 layer under T5, >60% cover)    

Shrub:  S1 seedling (<3 yr. old),   S2 young (<1% dead),   S3 mature (1-25% dead),   S4 decadent (>25% dead)   
 

Herbaceous: H1 (<12” plant ht.), H2 (>12” ht.)    
                                                                                                              

Desert Riparian Tree/Shrub:  1  (<2ft. stem ht.),  2  (2-10ft. ht.),  3  (10-20ft. ht.),  4  (>20ft. ht.) 
                                                                                                             

Desert Palm/Joshua Tree:  1  (<1.5” base diameter),  2  (1.5-6” diam.),  3  (>6” diam.) 
 

□ 

□ 

□ 

III. INTERPRETATION OF STAND  
  
  

Field-assessed vegetation Alliance name:  ___________________________________________________________________________  
□ 

  

Field-assessed Association name (optional): _________________________________________________________________________ 
 

Adjacent Alliances/direction: _____________________________________/___________, _____________________________________/________ 
 

□ 

□ 

Confidence in Alliance identification:   L     M     H      Explain: ________________________________________________________ □ 

Phenology (E,P,L): Herb____ Shrub____ Tree____    Other identification or mapping information: □ 
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Database #: __________        SPECIES SHEET  
 

IV.  VEGETATION DESCRIPTION 
 

                                                                                                         % NonVasc cover:____ Total % Vasc Veg cover:_____ 
 

% Cover -        Conifer tree / Hardwood tree:  _____/_____     Regenerating Tree:  _____    Shrub:  _____   Herbaceous: _____ 
 

Height Class  - Conifer tree / Hardwood tree:  _____/_____     Regenerating Tree:  _____    Shrub:  _____   Herbaceous: _____ 
  

Height classes: 1=<1/2m,  2=1/2-1m,  3=1-2m,  4=2-5m,  5=5-10m,  6=10-15m,  7=15-20m,  8=20-35m,  9=35-50m,  10=>50m   
 

□ 

□ 

□ 

 

Stratum categories: T=Tree, A = SApling, E = SEedling, S = Shrub, H= Herb, N= Non-vascular 

% Cover Intervals for reference: r = trace,  + = <1%,   1-5%,   >5-15%,   >15-25%,   >25-50%,   >50-75%,   >75% 

Stratum  Species % cover   C  Final species determination 

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

 

Unusual species: _______________________________________________________________________________________________ 
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1. INTRODUCTION  
This document summarizes the 2015-2017 monitoring results from implementation of the 2018 
Little Red Mountain Ecological Reserve Kellogg’s Buckwheat Monitoring Plan (Monitoring Plan). 
The Monitoring Plan is included as Part 1 of this report and includes detailed instructions on 
how to implement the monitoring protocol for Kellogg’s buckwheat (Eriogonum kelloggii) at the 
California Department of Fish and Wildlife (CDFW) Little Red Mountain Ecological Reserve 
(Reserve). The purpose of the Monitoring Plan is to facilitate adaptive management of the 
population of Kellogg’s buckwheat in the approximately 850 acre western area of the Reserve 
that is associated with serpentine habitat (Study Area). Implementation of the Monitoring Plan 
began in 2015 and an additional monitoring visit was conducted in 2017. CDFW recommends 
that another monitoring visit be conducted in 2022, with subsequent monitoring visits occurring 
every five years thereafter. This document includes an interpretation of results, an assessment 
of the monitoring project, and management recommendations. The results and 
recommendations in this document are a critical step in the adaptive management process. 

2. SUMMARY OF RESULTS 
This document reports on the result of the following monitoring components: 

1. A census documenting the size and location of all Kellogg’s buckwheat plants in the 
Study Area relative to a baseline,  

2. Photomonitoring of the Kellogg’s buckwheat population, and 
3. Opportunistic surveys of the Study Area for Kellogg’s buckwheat and other plants. 

 
In addition, precipitation information generated using a PRISM climate model is presented and 
general observations of other rare plants on the Reserve are reported. Abridged site visit 
summaries from 2015 and 2017 have also been included as Appendix A and Appendix B.  

2.1. CENSUS OF POPULATION 

For the purposes of the census, a “clump” of Kellogg’s buckwheat is defined as an individual 
Kellogg’s buckwheat plant or group of plants that is at least 10 centimeters away from another 
Kellogg’s buckwheat plant. A “large” clump is defined as a clump that is at least 10 centimeters 
in diameter in any direction, and a “small” clump is defined as a clump that is less than 10 
centimeters in diameter in all directions.  

There were a total of 31 clumps of Kellogg’s buckwheat found in the Study Area in 2015 (15 
large and 16 small), and a total of 20 clumps of Kellogg’s buckwheat in the Study Area in 2017 
(10 large and 10 small). 12 clumps of Kellogg’s buckwheat identified in 2015 were missing in 
2017 (6 large and 6 small), 19 clumps from 2015 remained present in 2017, and 1 small clump 
that was not present in 2015 was found in 2017. 11 of the 12 plants that died between 2015 and 
2017 were located in an approximately two meter by three meter area. 

The changes in the Kellogg’s buckwheat population from 2015 to 2017 are represented in 
Figure 1.  

Two plants were observed blooming during the monitoring visit in 2015 and four plants were 
observed blooming during the monitoring visit in 2017. All of the blooming plants were greater 
than ten centimeters in diameter.  

  



Figure 1 
Changes in Eriogonum kelloggii population in Plot 1 at Little Red Mountain Ecological Reserve between 2015 and2017 

California Department of Fish and Wildlife  Little Red Mountain Ecological Reserve Kellogg’s Buckwheat Monitoring Plan 
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2.2. PHOTOMONITORING 

Seven monitoring photo positions were used in the Study Area in 2015 and 2017. Monitoring 
photos are presented in Figures 2 through 9.  

2.3. ADDITIONAL SURVEYS 

CDFW surveyed the areas of the Study Area indicated in Figure 10, but did not locate any 
additional populations of Kellogg’s buckwheat.  

2.4. PRECIPITATION 

Precipitation information generated using a PRISM climate model is presented in Figure 11 
(PRISM 2018). Kellogg’s buckwheat is a perennial plant that likely germinates in the fall after 
the onset of winter precipitation, and blooms between May and August. Growing season annual 
precipitation (fall to summer) is assumed to be an important factor for Kellogg’s buckwheat 
growth and survival. Growing season precipitation was below average in the 2013-2014, and 
2014-2015 growing seasons, but was above average in the 2015-2016 and 2016-2017 growing 
seasons.  

2.5. OTHER OBSERVATIONS 

In addition to Kellogg’s buckwheat, other rare plants were also observed in the Study Area in 
2015 and 2017 (see Figure 10). The California endangered Red Mountain catchfly (Silene 
campanulata ssp. campanulata) was observed in Study Area in 2015 and 2017, and the rare 
white-flowered rein-orchid (Piperia candida) (California Rare Plant Rank of 1B.2) was observed 
at two locations in the Study Area and north of the Study Area on Bureau of Land Management 
(BLM) land. Despite attempts in 2015 and 2017, CDFW was not able to locate the 
Arctostaphylos stanfordiana ssp. raichei shrub (California Rare Plant Rank 1B.1) that was noted 
in the summary of the 2003 visit to the Study Area. Additional observations are available within 
the abridged site visit summaries from 2015 and 2017 that have been included as Appendix A 
and Appendix B. 

3. INTERPRETATION OF RESULTS 
Considering field notes from 2003 (Golec 2003) and information generated from monitoring 
visits in 2015 and 2017, it is clear that the population of Kellogg’s buckwheat in the Study Area 
suffered a significant decline between 2003 and 2017. Clare Golec observed the Kellogg’s 
buckwheat population in the Study Area in both 2003 and 2015, and observed the population to 
be less extensive in 2015 than it was in 2003. Instead of occurring on both sides of the road, as 
it did in 2003, the population now only occurs on the west side of the road. Monitoring visits in 
2015 and 2017 also clearly show a significant decline in the population, primarily due to the 
death of six plants that were greater than ten centimeters in diameter and six plants that were 
less than ten centimeters in diameter. This mortality event was concentrated in an 
approximately two by three meter area of the population (see Figure 4). This loss in population 
could have occurred due to a small land slide localized in this area or some other factor. The 
carcass of one of the large dead plants is apparent in Figure 4, but there is no obvious reason 
for the deaths of plants in this area.  

  



Figure 2 
Little Red Mountain Ecological Reserve Photopoint A, 2015 (above) and 2017 (below) 
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Figure 2 
Little Red Mountain Ecological Reserve Photopoint A, 2015 (above) and 2017 (below) 
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Figure 3 
Little Red Mountain Ecological Reserve Photopoint B, 2015 (above) and 2017 (below) 
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Figure 4 
Little Red Mountain Ecological Reserve Photopoint B (closeup), 2015 (above) and 2017 (below) 
California Department of Fish and Wildlife  Little Red Mountain Ecological Reserve Kellogg’s Buckwheat 2015-2017 Results and Discussion 

 



Figure 5 
Little Red Mountain Ecological Reserve Photopoint C, 2015 (above) and 2017 (below) 
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Figure 6 
Little Red Mountain Ecological Reserve Photopoint D, 2015 (above) and 2017 (below) 
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Figure 7 
Little Red Mountain Ecological Reserve Photopoint E, 2015 (above) and 2017 (below) 

California Department of Fish and Wildlife  Little Red Mountain Ecological Reserve Kellogg’s Buckwheat 2015-2017 Results and Discussion 

 



Figure 8 
Little Red Mountain Ecological Reserve Photopoint F, 2015 (above) and 2017 (below) 

California Department of Fish and Wildlife  Little Red Mountain Ecological Reserve Kellogg’s Buckwheat 2015-2017 Results and Discussion 

 



Figure 9 
Little Red Mountain Ecological Reserve Photopoint G, 2015 (above) and 2017 (below) 

California Department of Fish and Wildlife  Little Red Mountain Ecological Reserve Kellogg’s Buckwheat 2015-2017 Results and Discussion 
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Figure 11 
Little Red Mountain Ecological Reserve Precipitation September 2013 – August 2017 

California Department of Fish and Wildlife  Little Red Mountain Ecological Reserve Kellogg’s Buckwheat 2015-2017 Results and Discussion 
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4. ASSESSMENT OF THE MONITORING PROJECT 
The monitoring project has been largely successful. Our methods have resulted in an 
understanding of the current extent of the Kellogg’s buckwheat population in the Study Area, 
and a greater understanding of the botanical diversity of the Study Area, in general. The 
monitoring requires spending the night on the Reserve and significant planning, therefore the 
Monitoring Plan may be difficult to implement, long-term.  

Attempts to precisely align monitoring photos has been difficult. Precise alignment of monitoring 
photos is important because it allows direct comparison of specific areas of the ground in the 
photograph, and it may be very difficult to determine which areas of the ground are the same if 
two monitoring photos are even slightly misaligned. Differences in perspective resulting from 
photographs taken with different cameras, from slightly different positions and in slightly 
different directions can be very distracting, and may require careful correction with photo editing 
software such as Adobe Photoshop before insightful comparisons become possible. Because 
correcting the differences in perspective requires photo editing expertise and a considerable 
time commitment, every effort should be made to standardize monitoring photos as much as 
possible in the field. A workflow for correcting images in Photoshop has been included with this 
report as Appendix C.  

5. MANAGEMENT RECOMMENDATIONS 
The management objective and management implication identified in the Monitoring Plan are 
repeated below, with a discussion of whether the management implication should be triggered 
based on the monitoring results.  

5.1. MANAGEMENT OBJECTIVE #1 

Maintain a population of at least ten Eriogonum kelloggii plants with a diameter of ten 
centimeters or greater at Little Red Mountain Ecological Reserve at the time of the next 
monitoring visit, expected to be in 2022. (This is a target/threshold type of management 
objective.) 

Management Implication 1 from Monitoring Plan: If a population of at least ten Eriogonum 
kelloggii plants with a diameter of 10 centimeters or greater is not present at Little Red Mountain 
Ecological Reserve at the time of the next monitoring visit, expected to be in 2022, CDFW shall 
organize and initiate an effort to collect seeds from remaining plants in 2023, and preserve them 
in long-term conservation storage. 

Recommendation: This management implication would not be triggered until 2022; however, 
because the population is so small, any additional loss of mature plants in the population in the 
next five years would likely trigger this management implication.  

Management Implication 2 from Monitoring Plan: If a population of at least ten Eriogonum 
kelloggii plants with a diameter of 10 centimeters or greater is not present at Little Red Mountain 
Ecological Reserve at the time of the next monitoring visit, expected to be in 2022, CDFW shall 
organize and initiate a seed germination study, and attempt to grow Eriogonum kelloggii plants 
in a controlled environment, in an effort to obtain information that could lead to reintroduction of 
Eriogonum kelloggii to Little Red Mountain Ecological Reserve, if necessary. 
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Recommendation: This management implication would not be triggered until 2022; however, 
because the population is so small, any additional loss of mature plants in the population in the 
next five years would likely trigger this management implication.  

5.2. OTHER RECOMMENDATIONS 

CDFW should continue to survey the Study Area and Reserve whenever site visits are 
conducted, and collect additional scientific information. CDFW should continue to engage 
CDFW staff and others with the monitoring and management of the Study Area. 

6. REFERENCES 
Elzinga, C.L., D.W. Salzer, and J. Willoughby. 1998. Measuring and Monitoring Plant 
Populations. BLM Technical Reference 1730-1. U.S. Dept. of the Interior, Bureau of Land 
Management, Denver, CO. 492 pp. 

PRISM Climate Group. 2018. Oregon State University. Available online at: 
http://prism.oregonstate.edu. [Accessed April 12, 2018]. 
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Appendix A 

  



Notes and Monitoring Data from Field Visit to California Department of Fish and Wildlife’s 
Little Red Mountain Ecological Reserve, June 8 – June 10, 2015. Prepared by Jeb Bjerke. 
 

 Jeb Bjerke (Native Plant Program) 

 Cherilyn Burton (Native Plant Program) 

 Clare Golec (Region 1) (6/9 and 6/10 only) 

 Scott Koller (Region 1, reserve manager) 
(6/8 only) 

 Kristi Lazar (California Natural Diversity 
Database) 

 Brandon Rose (warden) (6/8 only) 
 

 
 

Eriogonum kelloggii closeup of foliage 

Narrative Summary:  
Monday June 8: Hot sunny and clear. Jeb, Cherilyn and Kristi met with Scott and Warden Rose 
on the north side of Highway 101, exit 609. Scott and Warden Rose were speaking with the 
adjacent landowner. Access to the Ecological Reserve requires crossing through private 
property. The property owner cleared some downed trees from the access route for CDFW staff 
to be able to access the reserve. Jeb, Cherilyn and Kristi were traveling in the Habitat 
Conservation Planning Branch’s 4WD Dodge Durango, and Scott and Warden Rose drove in 
their respective trucks. Scott told us that the road ahead was blocked by downed trees and 
Warden Rose let us borrow his tow chain to move them. We said goodbye to Scott and Warden 
Rose and headed further along the road, having to use the tow chain to move several large 
downed trees off of the road. We tried to get to an old wildland firefighting campsite just outside 
of the western edge of the Ecological Reserve, but the clearance of our vehicle was not 
sufficient to pass a rocky and eroded water bar that crossed the road, so we parked and 
camped at a road junction near the rare plant populations. We used the rest of the day to scout 
the area and mark targeted rare plants with pin flags (Silene campanulata subsp. campanulata 
and Eriogonum kelloggii).  
 
Tuesday June 9: Warm, sunny and clear at 7:30am. Jeb, Cherilyn and 
Kristi resumed scouting for plants and found several populations of S. 
c. campanulata but only one small population of E. kelloggii. We 
completed a CNDDB form for the Silene populations and took GPS 
points to document the location of these populations. Clare Golec 
joined us at around noon. The E. kelloggii was observed at the same 
location that it was observed in 2003, however Clare told us that the 
population is now less extensive and instead of occurring on both 
sides of the road, as it did in 2003, it now only occurs on the West 
side of the road. We installed 3 field monuments each consisting of a 
rebar stake sheathed in a length of PVC pipe with a red cap, all 
sheathed in a length of square aluminum conduit, all hammered into 
the ground and labeled with an aluminum tag (photo right). One 
monument was placed south of the E. kelloggii population and one monument was placed north 
of the E. kelloggii population. These monuments are 15 meters away from each other along the 
road. A third monument was placed on the opposite side of the road from the E. kelloggii 
population to serve as a permanent photopoint. We defined two different size classes for 
“clumps” of E. kelloggii plants; large clumps were defined as having a long diameter of more 
than 10 cm, and small clumps were defined as having a long diameter of no more than 10 cm. If 



two plants or clumps were less than 10 cm apart from one another, they were counted together 
as one clump. We counted all E. kelloggii clumps and documented their location relative to a 15 
meter-long baseline that ran between the South monument (the 0 meter mark) and the north 
monument (the 15 meter mark) (see figure and datasheet). We counted a total of 31 clumps of 
E. kelloggii, consisting of: 
 

 16 small (<10 cm) clumps of E. kelloggii 

 15 large (>10 cm) clumps of E. kelloggii 
o 2 of these large clumps were blooming (and none of the small clumps were 

blooming) 
 

The E. kelloggii was found growing in and above the road cut, and some small clumps, often 
consisting of only one plant, were found growing in the road. We searched along both sides of 
the road and a significant distance both upslope and downslope from the population and were 
unable to find any additional E. kelloggii plants.  
 
With the rest of the afternoon, we scouted additional areas of the reserve to look for E. kelloggii, 
S. c. campanulata and other plant species, and were able to find an additional population of S. 
c. campanulata (see CNDDB form). Clare said goodbye for the day in the late afternoon, and we 
went for an evening stroll to continue scouting for plants. 
 
 

 
Silene campanulata subsp. campanulata flowers 
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Eriogonum kelloggii 

 
Wednesday June 10: We met back up with Clare in the morning and continued to scout the 
reserve for additional populations of the species. We went on a loop hike and left the previously 
cleared roads to hike up a steep slope and after crawling through dense manzanita we found 
some additional populations of S. c. campanulata near an area that was cleared for a helicopter 
landing pad during a fire that took place in the area in (2008?). The Arctostaphylos regenerating 
within the helicopter landing area appeared to be diseased. All of the S. c. campanulata that we 
observed during our visit seemed to occur in areas with at least some shade or shelter, whether 
it be a north(ish)-facing slope with some tree overstory, underneath an Arctostaphylos shrub 
canopy, or on the bank of a dry drainage channel with tree overstory. Next we hiked down to an 
area of the reserve with a grassland/oak woodland plant community without red soil. We 
returned to our vehicles at about noon and left the reserve.  
 
An updated list of plant species discovered on the reserve is attached, along with a very 
approximate map of the areas that were traveled and surveyed.  
 
Eriogonum kelloggii Monitoring Data and Photos: 
Little Red Mountain Ecological Reserve, 6/9/2015 
 
Field Personnel: Jeb Bjerke, Cherilyn Burton, Kristi Lazar; Clare Golec joined around noon 
Location: Roadcut on west side of old mining/fire road. Associated plant species: Calocedrus 
decurrens, tan oak, Arctostaphylos sp., Pinus jeffreyi, Pinus lambertiana, Silene campanulata 
ssp. campanulata, Polygala sp. 
 
2015 Monitoring Methods: Two (2) rebar monuments were hammered into the west side of the 
road, 15 meters apart along the road; PVC pipe with a cap was placed over the rebar and 
square aluminum conduit was placed around the PVC. The monuments were named CDFW 
Plot 1 South (UTM: 4413592 northing, 442717 easting) and CDFW Plot 1 North (UTM: 4413607 
northing, 442717 easting). A meter tape was laid between the two monuments (from south to 
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0 0.05 0.1 0.2 Miles
I I I I I I I I I

N
Little Red Mountain Site Map



north), and the locations of plants, relative to the tape were measured. The point where plants 
were closest to the baseline was recorded. If separate plants were less than 10 cm apart from 
each other, they were counted as one “clump”. Plants were recorded at the following locations: 
 
16 Small clumps (<10cm in diameter on all sides): 

570N/30W 

740N/40W 

1000N/15W 

1000N/60W 

1070N/50W 

1090N/40W 

730N/120W 

820N/180W 

810N/230W 

830N/190W 

840N/240W 

825N/240W 

740N/30E 

840N/40E 

860N/80E 

1130N/10E (Series of small plants, just barely <10cm) 

 
15 Large Clumps (>10cm diameter on any side) 

220N/80W 

810N/40W (7 small clumps that combined are >10cm) 

1030N/5W 

1120N/150W (Composed of 2 smaller clumps, 1 blooming) 

1000N/150W 

1000N/210W 

780N/130W 

770N/100W 

830N/120W (Several smaller clumps ~45cm long) 

560N/310W (Flowering, largest clump present directly behind cedar) 

720N/270W 

775N/310W (2 very small plants and one 1x3cm clump) 

790N/340W 

850N/390W 

730N/520W 

 
Photomonitoring Methods:   
A third monument, named Plot 1 photo point (UTM: 4413600 northing, 442721 easting) was 
placed on the east side of road about 4.6 meters(?) east of the 7.5 meter mark on the baseline. 
(half-way between the plot monuments that are on the west side of the road). Seven monitoring 
photos were captured: 
  



A – From photo monument with south plot monument centered in bottom 1/3 of image 

 
B – From photo monument with 7.5m mark (center) of baseline centered in bottom ¼ of image 

 



C – From photo monument with north plot monument centered in bottom 1/3 of image 

 
D – From north monument with south monument centered in top 1/3 of view 

 



E -From 150cm east of south monument (due to blocked view) with 7.5m baseline mark in 
bottom ¼ of image 

 
F – Approximately 3m south of photo monument with 7.5m baseline mark centered in bottom ¼ 
of image  

 



G- Approximately 3m north of photo monument with 7.5m baseline mark centered in bottom ¼ 
of image

 
 
 



Appendix B 

  



Notes and Monitoring Data from Field Visit to California Department of Fish and Wildlife’s 
Little Red Mountain Ecological Reserve, June 13 – June 15, 2017. Prepared by Jeb 
Bjerke. 
 
 

 Jeb Bjerke (Native Plant Program) 

 Cherilyn Burton (Native Plant Program) 

 Danielle Castle (Region 1 Timber Program, 
Mendocino County) (June 13 and 14) 

 
Narrative Summary:  
Tuesday June 13: Sunny and mild. Jeb and Cherilyn 
met with Danielle in her work truck on the north side 
of Highway 101, exit 609 and proceeded through the 
first gate to the Reserve. Access to the Ecological 
Reserve requires crossing through private property. 
Jeb coordinated with the property owner prior to the 
visit via phone. The property owner volunteered to 
check and clear the road of obstructions prior to the 
visit. The road to the reserve was very rutted and 
worn, and passage required a high clearance vehicle 
(https://binged.it/2sYmy7o). We encountered the 
property owner after going through the second 
locked gate. The property owner was cutting and 
splitting wood along the access road. We introduced 
ourselves and chatted with the property owner before proceeding to the reserve.  
 
On our way to the west side of the reserve we drove over 4-5 foot tall regenerating shrubs and 
cleared some minor woody debris by hand. We parked at the junction of the road that leads to 
the Eriogonum kelloggii population (39.874455°, -123.668826°) and proceeded on foot. We 
found a few state endangered Silene campanulata ssp. campanulata near the road, near 
areas the species has been known to occur. We marked the known population of Eriogonum 
kelloggii with pin flags and proceeded to search for the Arctostaphylos stanfordiana ssp. 
raichei shrub that was observed in 2003. We searched the area, but were unable to find the 
plant, and suspect that it may have been cut down during a fire that took place in the area in 
2008. We bushwacked uphill and searched some of the area above the known Eriogonum 
kelloggii population. We returned to the trucks and camped at 39.874344°, -123.667687°. 
 
Wednesday June 14: Sunny and mild. We monitored the Eriogonum kelloggii population by 
recording the location of every plant clump, or group of plant clumps we found relative to the 
baseline created by extending a meter tape from the South Plot Monument to the North Plot 
Monument (15 meters). We numbered each clump, recorded the maximum diameter of each 
clump or group of clumps, whether the clump had flowers, and made other notes. We also 
took monitoring photos, and took a photo of each clump. 
 
We counted a total of 19 clumps of E. kelloggii, consisting of: 
 

 10 small (<10 cm) clumps of E. kelloggii 

 10 large (>10 cm) clumps of E. kelloggii 

Eriogonum kelloggii with flowers 

almost open 

 

https://binged.it/2sYmy7o


o 4 of these large clumps were blooming (and none of the small clumps were 
blooming) 

 
It appears that a number of plants present at about 8 meters along the baseline and 3.5 
meters to the west of the baseline that were present in 2015 were no longer present in 2017. 
The carcass of the largest plant on the slope was still present, be we did not see any 
remnants of the other (smaller) missing plants.   
 
After completing the monitoring we returned to camp and then began scouting for other 
populations of Eriogonum kelloggii on the reserve. Danielle collected some moss from a rock 
at (39.870451, -123.653190) to send to bryophyte experts, and collected one voucher 
specimen of Silene campanulata ssp. campanulata to deposit in an herbarium. We said 
farewell to Danielle at about 3:00 pm, and we continued searching. We did not find any 
additional populations of Eriogonum kelloggii during the afternoon, but we did discover some 
additional populations of the state endangered Silene campanulata ssp. campanulata, and 
several individuals of the rare orchid Piperia candida (see attached figure).  
 
Thursday June 14: Warm, with high clouds. We continued scouting for other populations of 
Eriogonum kelloggii on the reserve, and searched above the known population. We reached the 
top of Little Red Mountain and searched the paths along the west and north sides of the 
mountain. We searched another area to the east of our campsite, and then left the reserve. 
 
Eriogonum kelloggii Monitoring Data and Photos: 
Little Red Mountain Ecological Reserve, 6/14/2017 
 
Field Personnel: Jeb Bjerke, Cherilyn Burton, Danielle Castle 
Location: Roadcut on west side of old mining/fire road. Associated plant species: Calocedrus 
decurrens, Notholithocarpus densiflorus var. densiflorus, Arctostaphylos sp., Pinus jeffreyi, 
Pinus lambertiana, Silene campanulata ssp. campanulata, Polygala californica. 
 
2017 Monitoring Methods: A meter tape was laid from south to north between the South Plot 
Monument and the North Plot Monument (15 meters), and the locations of plants, relative to the 
tape were measured. The point where plants were closest to the baseline was recorded. If 
separate plants were less than 10 cm apart from each other, they were counted as one “clump”. 
Plants were recorded at the following locations: 



Description

Number of 

Plants Date

Feature 

Type Species Latitude Longitude Notes

sicaca2 0 20150609 Plant Silene campanulata ssp. campanulata 39.874153 -123.669356

sicaca3 0 20150609 Plant Silene campanulata ssp. campanulata 39.869997 -123.669842

sicaca4 0 20150609 Plant Silene campanulata ssp. campanulata 39.869565 -123.669826

sicaca5 0 20150609 Plant Silene campanulata ssp. campanulata 39.868483 -123.669897

erikel1 0 20150609 Plant Eriogonum kelloggii 39.870448 -123.669799

erikel2 0 20150609 Plant Eriogonum kelloggii 39.870511 -123.669812

erikel3 0 20150609 Plant Eriogonum kelloggii 39.870565 -123.669800

silene campanulata campanulata 75 20150609 Plant Silene campanulata ssp. campanulata 39.869324 -123.664702

sicaca1 0 20150609 Plant Silene campanulata ssp. campanulata 39.874153 -123.669356

sicaca1 0 20150609 Plant Silene campanulata ssp. campanulata 39.874180 -123.669438

sicaca1 0 20150609 Plant Silene campanulata ssp. campanulata 39.874234 -123.669427

sicaca1 0 20150609 Plant Silene campanulata ssp. campanulata 39.874242 -123.669591

silene campanulata campanulata 200 20150609 Plant Silene campanulata ssp. campanulata 39.868019 -123.669133

silene campanulata campanulata 100 20150609 Plant Silene campanulata ssp. campanulata 39.867973 -123.669331

silene campanulata campanulata 200 20150609 Plant Silene campanulata ssp. campanulata 39.868285 -123.669907

SILENE CAMPANULATA CAMPANULATA 25 20170614 Plant Silene campanulata ssp. campanulata 39.870458 -123.652109 5% flowering, under tanoak and dead manzanita

PIPERIA CANDITA 1 20170614 Plant Piperia candida 39.870730 -123.652051 almost flowering, under sugar pine, lots of bear grass nearby

SILENE CAMPANULATA CAMPANULATA 80 20170614 Plant Silene campanulata ssp. campanulata 39.871095 -123.652135 near red huckleberry, manzanita and bear grass

SILENE CAMPANULATA CAMPANULATA 1 20170614 Plant Silene campanulata ssp. campanulata 39.870732 -123.652443

SILENE CAMPANULATA CAMPANULATA 10 20170614 Plant Silene campanulata ssp. campanulata 39.876240 -123.658047

PIPERIA CANDITA 0 20170614 Plant Piperia candida 39.876523 -123.658429

SILENE CAMPANULATA CAMPANULATA 25 20170614 Plant Silene campanulata ssp. campanulata 39.876542 -123.658407

SILENE CAMPANULATA CAMPANULATA 25 20170614 Plant Silene campanulata ssp. campanulata 39.876442 -123.658749

SILENE CAMPANULATA CAMPANULATA 25 20170614 Plant Silene campanulata ssp. campanulata 39.876023 -123.658877

PIPERIA CANDITA 1 20150609 Plant Piperia candida 39.871600 -123.665616 flowering



 
 

Clump 
Number 

Distance in Meters 
along baseline (from 
south to north) 

Distance 
from 
baseline 
(East or 
West) 

Widest 
part of 
clump 
(cm) 

Flowering  

1 2.15 West 0.76  26 No 

2 7.4 East 0.39 5 No 

3 7.42 West 0.33 1 No 

4 7.34 West 1.13 6 No 

5 7.73 West 0.92 21 No 

6 7.87 West 0.37 9 No 

7 8.4 East 0.505 8.5 No 

8 8.69 East 0.84 8 No 

9 7.63 West 5.05 58 Yes 

10 5.4 West 2.91 40 Yes 

11 9.77 East 1.76 3 No 
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Relative sizes of Eriogonum kelloggii plant clumps at 
Little Red Mountain Ecological Reserve on June 14, 2017

Vegetative Flowering



12 9.96 West 0.115 2 No 

13 10 West 0.52 9 No 

14 10.24 0 16 No 

15 9.96 West 1.435 38 No 

16 9.93 West 1.92 19 Yes 

17 10.62 West 0.415 9 No 

18 10.85 West 0.34 10.5 No 

19 11.01 West 1.45 43 Yes 

20 11.36 East 0.105 17 No 

 
 
Photomonitoring Methods:   
Each clump was photographed, and photographs are saved in the Native Plant Program’s files. 
A third monument, named Plot 1 photo point (UTM: 4413600 northing, 442721 easting) was 
placed on the east side of road about 4.6 meters(?) east of the 7.5 meter mark on the baseline. 
(half-way between the plot monuments that are on the west side of the road). Seven monitoring 
photos were captured:  
 
A – From photo monument with south plot monument centered in bottom 1/3 of image 

 
 
 
 
 
 



B – From photo monument with 7.5m mark (center) of baseline centered in bottom ¼ of image 

 
C – From photo monument with north plot monument centered in bottom 1/3 of image

 



D – From north monument with south monument centered in top 1/3 of view 

 
E -From 150cm east of south monument (due to blocked view) with 7.5m baseline mark in 
bottom ¼ of image 

 



F – Approximately 3m south of photo monument with 7.5m baseline mark centered in bottom ¼ 
of image  

 
G- Approximately 3m north of photo monument with 7.5m baseline mark centered in bottom ¼ 
of image

 









Little Red Mountain Ecological Reserve Plant Species List  

This list is an updated version of the June 2004 plant list prepared by Clare Golec. Updated 
scientific names and additional plant species are marked with an asterisk(*). Some plant 
species on grassland habitat within the reserve that was not on the characteristic “red” 
serpentine soil were also included in the list below and are designated with “(grassland)”. Areas 
visited in 2015 and 2017 are identified on the figure in this report.   
 
Family 
Scientific Name Listing status    Common Name  
  
Alliaceae 
Allium falcifolium      scythe-leaved onion 
Allium amplectens*     narrow-leaved onion 
 
Anacardiaceae 
Toxicodendron diversilobum*    western poison oak 
 
Apiaceae  
Lomatium sp. (engelmannii? 4.3)    lomatium 
Sanicula laciniata*      coastal blacksnakeroot 
 
Apocynaceae 
Apocynum androsaemifolium    bitter dogbane  
Asclepias speciosa*     showy milkweed 
 
Asteraceae 
Achillea millefolium      common yarrow  
Arnica discoidea*      rayless arnica 
Cirsium douglasii var. breweri    swamp thistle 
Cirsium sp.* (grassland)    thistle 
Erigeron reductus var. angustatus*    little rayless fleabane  
Eriophyllum lanatum var. achilleoides*  woolly sunflower 
Hemizonia congesta ssp. tracyi* (grassland)  Tracy’s tarplant 
Hieracium bolanderi*     Bolander’s hawkweed 
 
Boraginaceae 
Eriodictyon californicum     California yerba santa 
 
Caryophyllaceae 
Silene campanulata ssp. campanulata SE, 4.2  Red Mountain catchfly 
 
Cupressaceae 
Calocedrus decurrens     incense cedar 
 
Cyperaceae 
Carex amplifolia      ample-leaved sedge 
 
Dennstaedtiaceae 
Pteridium aquilinum var. pubescens    western bracken fern  
 



Dryopteridaceae 
Polystichum imbricans ssp. imbricans*  sword fern 
 
Ericaceae 
Arctostaphylos canescens ssp. sonomensis  Sonoma manzanita 
Arctostaphylos manzanita ssp. manzanita*  Common manzanita 
Arctostaphylos stanfordiana ssp. raichei 1B.1  Raiche's manzanita   
Chimaphila menziesii      little prince’s pine 
Pyrola aphylla*     leafless wintergreen 
Vaccinium parvifolium     red huckleberry  
 
Fabaceae 
Lupinus andersonii*     Anderson’s lupine 
Trifolium eriocephalum ssp. eriocephalum*   hairy head clover 
(grassland)    
 
Fagaceae 
Notholithocarpus densiflorus var. densiflorus  tanbark oak 
Quercus vacciniifolia*     huckleberry oak  
 
Hydrangeaceae 
Whipplea modesta      yerba de selva  
 
Iridaceae 
Iris purdyi       Purdy’s iris 
 
Juncaceae 
Luzula comosa      common wood rush 
 
Liliaceae 
Calochortus tolmiei      pussy ears 
Calochortus vestae*(grassland)   Mariposa lily 
Erythronium sp.*     fawn lily 
Lilium rubescens 4.2      redwood lily 
 
Linaceae 
Hesperolinon clevelandii*    dwarf flax 
 
Malvaceae 
Sidalcea diploscypha*(grassland)   fringed checkerbloom 
 
Melanthiaceae 
Toxicoscordion micranthum     death camas 
Xerophyllum tenax      bear-grass 
 
Onagraceae 
Epilobium minutum*     willowherb 
 
Orchidaceae  
Piperia candida1B.2*     white-flowered rein-orchid 
 



Orobanchaceae 
Castilleja applegatei ssp. pinetorum*   wavy-leaved indian-paintbrush 
Cordylanthus tenuis ssp. brunneus*    serpentine bird’s-beak 
Orobanche pinorum*     broomrape 
Orobanche uniflora*     naked broomrape 
Pedicularis densiflora      Indian warrior  
 
Pinaceae 
Pinus attenuata*     knobcone pine 
Pinus jeffreyi       Jeffrey pine 
Pinus lambertiana      sugar pine  
Pseudotsuga menziesii var. menziesii   Douglas-fir 
 
Poaceae 
Avena sp.* (grassland)    wild oat   
Briza minor* (grassland)    little quaking grass 
Bromus hordeaceus* (grassland)   soft chess 
Bromus diandrus* (grassland)     ripgut grass 
Cynosurus echinatus* (grassland)   dogtail grass 
Deschampsia caespitosa ssp. caespitosa   tufted hair-grass 
Elymus sp.       wild rye  
Elymus caput-medusae* (grassland)   medusa head 
Festuca californica*     California fescue 
Festuca idahoensis*     blue bunchgrass 
Festuca rubra*     red fescue 
Melica sp.       oniongrass  
 
Polygalaceae 
Polygala californica      California milkwort  
 
Pteridaceae 
Aspidotis densa      Indian’s dream 
 
Polygonaceae 
Eriogonum kelloggii SE, FC, 1B.2    Kellogg's buckwheat 
Eriogonum nudum var. nudum*   naked wild buckwheat 
 
Ranunculaceae 
Delphinum sp.* (grassland)    larkspur 
Ranunculus sp.* (grassland)    buttercup 
 
Rhamnaceae 
Ceanothus foliosus var. foliosus    wavy-leaf ceanothus  
Ceanothus pumilus      Siskiyou ceanothus 
Frangula californica ssp. occidentalis *  California buckthorn 
 
Rosaceae 
Heteromeles arbutifolia     toyon  
Holodiscus discolor var. glabrescens*  oceanspray 
Horkelia tridentata var. flavescens*   horkelia 
Potentilla?*      



Rosa sp.*      Rose 
 
Rubiacae 
Galium ambiguum ssp. siskiyouense *  Yolla Bolly bedstraw 
Galium sp. #2       bedstraw  
 
Themidaceae 
Brodiaea elegans ssp. elegans* (grassland)  harvest brodiaea 
 
Violaceae 
Viola ocellata*      two-eyed violet 
Viola lobata spp. lobata     pine violet 
 
Bird species list by C. Burton: 

 Anna’s hummingbird  

 black-throated gray warbler 

 California quail (call) 

 dark eyed junco (song) 

 hermit thrush (song) 

 mountain quail (call) 

 northern flicker (call) 

 olive-sided flycatcher (song) 

 red-breasted nuthatch (song) 

 red-tailed hawk (call) 

 spotted towhee (song) 

 Stellar’s jay 

 turkey vulture 

 wrentit (song) 

 western wood-pewee (song) 
 

Other observations: 

 bear scat with evidence of red huckleberry and grass consumption 

 red velvet ant 

 chanterelle  

 moss collected by Danielle at (39.870451, -123.653190) 

 many red-colored western fence lizards, likely due to dust 



Appendix C 



Workflow for Aligning Monitoring Photos in Photoshop 

This procedure provides a rough outline of a technique for aligning monitoring photos taken from the 

same location using Photoshop CS6. 

1. Open Photoshop CS6 

2. Under “File”, select “Scripts” > “Load Files into Stack” 

3. Select “Browse” and select all monitoring photos you would like to align 

a. Only check “Attempt to Automatically Align Source Images” if there are lots of 

buildings or other visually distinct aspects to the image, and even then, this may not 

work well. If the result does not look good, start over and uncheck this box. 

4. Select “Image”, and “Canvas Size” and increase the vertical and horizontal canvas size by a few 

inches. 

5. Select the top layer in the layers window, select “Filter” and “Lens Correction…” For “Edge” 

select “Edge Extension”. Select OK.  

a. NOTE: For photos taken with an SLR camera (Nikon d3100/d3300) a lens profile is 

available, and should be used. The Native Plant Program point and shoot Sony camera 

does not have a lens profile, so skip the lens correction step for photos taken on the 

Sony.  

6. Use the eye button to make the top layer that was just corrected invisible, click on the next 

layer down to select it, and repeat Step 5 for all remaining monitoring photos.  

7. Make the top layer visible again and click it to select it in the layers window. Click and hold the 

eyedropper icon in the tools window, and select the ruler tool in the submenu. 

8. Click and hold on a specific feature on the horizon on the left side of the image, and drag a ruler 

line to a specific feature on the horizon on the right side of the image. Click the “Straighten 

Layer” button at the top of the window. Repeat steps 6 and 7 for the remaining layers so that 

the horizon is straightened in the same way for all monitoring photos. 

9. Select a reference photo with lots of landmarks and identifiable features, and move it down to 

the bottom layer in the layers window. (This will be your Reference Photo)  

10. Make all layers invisible in the layers window, except for the bottom two layers. Make the layer 

above the bottom layer about 50 percent transparent by selecting it in the layers window, and 

using the “Opacity” slider, so that you can see features from both images at the same time.  

11. Use the “Move Tool” by pressing V on the keyboard, and dragging the top layer so that it 

matches the bottom layer as best as possible. Getting the horizon to match as much as possible 

is a good first step. Matching features in the foreground is more difficult. There are several 

techniques that can be used to help with this: 

a. Resizing the layer by holding the shift key (to maintain aspect ratio) and clicking and 

dragging a corner of the layer.  -> be sure that “Show Transform Controls” is checked.  

b. “Edit” > “Transform” > “Warp” can be used to drag features to where they need to be. 

If a rock or tree needs to be moved to line up with the same rock or tree underneath, 

simply drag it and move it. You will likely need to go back to other areas of the photo to 

stretch everything into the right place. Just work on the photo until you are happy with 



the result. (Important note: do not accept the changes and apply the transformation by 

pressing the “enter” key until you are completely happy with the result. Every time you 

accept a transformation, the act is destructive, and it permanently degrades the quality 

of the image) 

c. “Edit” > “Transform” > “Perspective” can also be used if a side of the image is skewed in 

one way or the other. Grab the edge you want to move and move it. I have only used 

this successfully a few times, typically if most to the telephone poles are leaning in one 

direction, for instance.  

d. Once you have begun transforming the layer, you cannot turn the layer on and off to 

check your work anymore, and you should therefore use the “Opacity” slider to see 

what is underneath and check your work. 

12. When you have completed a layer, make it invisible with the eye button, and make the next 

layer above visible, select it, and continue with Steps 8, 9 and 10 until you have edited all of the 

layers. 

13. Select “File” > “Save As” and save the photoshop file as the photopoint name in the appropriate 

location on the U Drive, for example: U:\Groups\HCPB\Shared Folders\NPP\Section 

6\2014\Priority Plant Surveys\Project Files\Butte County Limnanthes Files\Stone Ridge\All 

renamed photos here for comparison\Aligned Photos\Aq  

(You might need to make a new Aligned photos folder in renamed photos folder) 

14. Make all layers visible and select all layers. Select “View” > “Show” > “Layer Edges” to give you 

an idea of where all of the layers overlap. Select the Rectangular Marquee Tool from the toolbar 

window (a dashed rectangle).  

15. Draw a selection within the area that all (or most) of the layers overlap. -> The layer edges will 

disappear once you start to draw your rectangle so be sure to get a good idea of where to draw 

before you start. 

16. After the photoshop file has been saved, crop the image down by selecting “Image” > “Crop” 

17. Make only the top layer visible and select it. If there are any areas along the edges where you 

can see the transparency underneath and want to fill it in with camouflage, select the area using 

the magic wand tool from the toolbar. After selecting the transparency, select “Select” > 

“Modify” > “Expand” and increase the selection by 5 pixels. 

18. Next click “Edit” > “Fill…” and select “Content Aware” to fill the blank areas.  

19. Next click “File” > “Save as”, change the file type to JPEG and save the file in the appropriate 

photopoint folder on the U drive, with the filename corresponding with that photopoint and the 

date the photo was taken. 

20. Repeat steps 15, 16 and 17 for the remaining layers.  
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